
Mini Tweezers Basic User Guide 
 
Chamber Construction and Plumbing: 
 
See “How to construct a microchamber.” 
 
Construction is similar to the protocol for the old Bustamante lab tweezers, with two changes.  
First, use number 2 glass slides which accomplishes two things. It reduces any variance due to 
deformations in the glass slide (greater thickness minimizes this effect). Also, it leaves less space 
between the lens and the chamber, which allows for the new emersion liquid to better stay in 
place. 
 
Second, do not use a bearing tube to thread the pipette tip into place. Instead seal the pipette tip 
in between the parafilm. This reduces drift from the movement of the pipette.  Attach the PE 10 
tubing with the UV setting glue. 
 
For plumbing lines, use the substitute PE 50 tubing. (Small Parts Inc, 800-220-4292, PTFE Tube 
light wall 24G 100’ Part # - STT-24-C).  If using a shunt use the dispenser size tubing, otherwise 
vibrations from the fluid can increase the noise of the bead. 
 
Note: There is a new gasket design (“pinched gasket”). 
 
Preference File Information: 
 
Preference files store user changes to machine variables (i.e., pulling protocols, feedback gains, 
stored locations, data recording, etc…).  These values are loaded when the program starts or 
when you import preference values.  They may be saved by exporting preference values. 
 
As an example, settings shown below are for the Bustamante lab “blue” mini tweezer using a 3.1 
um bead in the trap.   
 
@ ForceRateDiv 0   Force feedback speed, 0 = fastest (4000 Hz), 255 = slowest 
@ ForceGain 55   Adjust gain to prevent oscillation 
@ PosRateDivA 0   Position A feedback speed, 0 = fastest (4000 Hz), 255 = slowest 
@ PosRateDivB 0   Position B feedback speed, 0 = fastest (4000 Hz), 255 = slowest 
@ PositionGainA 64  Adjust gain to prevent oscillation 
@ PositionGainB 32          Adjust gain to prevent oscillation 
@ GotoSpeedX 15   Initial motor speed in X 
@ GotoSpeedY 15   Initial motor speed in Y 
@ GotoSpeedZ 7   Initial motor speed in Z 

@ MaxDataFileSize 100000000  File size in bytes. Will record files A – G then start to rewrite over A 
@ HopDistance 2               Trap displacement during hopping test.  1 unit = 1.6 Å 

 
******************************************************************************
********************** 
The following lines control what data are recorded in your output: 1 = recorded; 0 = not recorded 
  
@ *CycleCount/n____ 1  Sequential cycle count from main controller PIC (4000 Hz) 
@ *A_PsdX__________ 0  Trap A, Force PSD X output  



@ *A_PsdY__________ 0  Trap A, Force PSD Y output  
@ *A_PsdSum________1  Trap A, Force PSD SUM output (total light intensity) 
@ *A_Iris__________ 1  Trap A, Iris detector output (bullseye filtered intensity) 
@ *A_LeverX________ 0  Trap A, Lever PSD X output 
@ *A_LeverY________ 0  Trap A, Lever PSD Y output 
@ *A_LeverSum______ 0  Trap A, Lever PSD SUM output (total light intensity) 
@ *B_PsdY__________ 0  Trap B, Force PSD Y output  
@ *B_PsdSum________1  Trap B, Force PSD SUM output (total light intensity) 
@ *B_Iris__________ 1  Trap B, Iris detector output (bullseye filtered intensity) 
@ *B_LeverX________ 0  Trap B, Lever PSD X output 
@ *B_LeverY________ 0  Trap B, Lever PSD Y output 
@ *B_LeverSum______ 0  Trap B, Lever PSD SUM output (total light intensity) 
@ *A_Temperature___ 0  Temperature sensor A [deg C] 
@ *B_Temperature___ 0  Temperature sensor B [deg C] 
@ *X_force_________ 1  Calculated force in X direction [pN] 
@ *Y_force_________ 1  Calculated force in Y direction [pN] 
@ *Z_force_________ 1  Calculated force in Z direction [pN] 
@ *Tension_________ 1  sqrt(Fx

2+ Fy
2 +Fz

2)  
@ *A_dist-X________ 0  Calculated A trap displacement in X [nm] 
@ *A_dist-Y________ 1  Calculated A trap displacement in Y [nm] 
@ *B_dist-X________ 0  Calculated B trap displacement in X [nm] 
@ *B_dist-Y________ 1  Calculated B trap displacement in Y [nm] 
@ *Motor_X_________ 0  Calculated chamber displacement in X [µm] 
@ *Motor_Y_________ 0  Calculated chamber displacement in Y [µm] 
@ *Motor_Z_________ 0  Calculated chamber displacement in Z [µm] 
@ *MotorVel_X______ 0  Calculated chamber velocity in X [µm/s] 
@ *MotorVel_Y______ 0  Calculated chamber velocity in Y [µm/s] 
@ *MotorVel_Z______ 0  Calculated chamber velocity in Z [µm/s] 
@ *A_trapPIC_Err___ 0  Error report from A trap PIC 
@ *B_trapPIC_Err___ 0  Error report from B trap PIC 
@ *comPIC_Err______ 0  Error report from communications PIC 
@ *A_CycleCount____ 0  Cycle count from A trap PIC (16 bit, 4000 Hz) 
@ *B_CycleCount____ 0  Cycle count from B trap PIC (16 bit, 4000 Hz) 
@ *Motor_CycleCount 0  Cycle count from motor PIC 
@ *time(sec)_______ 1  Calculated time from communications PIC cycle count [s] 
@ *Status__________ 1    Indicates state of pulling protocols (i.e., waiting, hopping, pulling, stretching…) 
@ *Null____________ 0  Skipped channel 
 
******************************************************************************
**********************  
 
@ samples/line_HI 400  Data rate divider: low speed = 4000Hz / 400 = 10 Hz 
@ samples/line_LO 4  Data rate divider: high speed = 4000Hz / 4 = 1000 Hz (don’t go lower than 4) 
 
******************************************************************************
********************** 
Coordinates of motor “go to” positions.  Only valid for 1-7.  Usually represent dispenser and pipette tube positions.   
 
# goto0 0 0 0        
# goto1 8388608 8388608 8388608  



# goto2 8327896 8402399 8388608 
# goto3 8328928 8374564 8389522 
# goto4 8373693 8378995 8399187 
# goto5 0 0 0 
# goto6 0 0 0 
# goto7 0 0 0 
# goto8 0 0 0 
# goto9 0 0 0 
 
******************************************************************************
********************** 
 
# yourXYZint  123 456 789    Optional user variable for C programming- advanced 
$ MaxForceP1  20.000000  Maximum force in P1 pulling protocol [pN] 
$ MinForceP1  2.000000  Minimum force in P1 pulling protocol [pN] 
$ PullRateP1  100.000000  Pulling rate in P1 pulling protocol [nm/s] 
$ refoldTime1  0.000000  Time stall at minimum force [s]   
$ MaxForceP2  20.000000  Maximum force in P2 pulling protocol [pN] 
$ MinForceP2  2.000000  Minimum force in P2 pulling protocol [pN] 
$ PullRateP2  100.000000  Pulling rate in P2 pulling protocol [nm/s] 
$ refoldTime2  0.000000  Time stall at minimum force [s]   
$ constForce1  5.000000  Constant force 1 [pN] 
$ constForce2  18.000000  Constant force 2 [pN] 
$ yourFloat   1.234000  Optional user variable for C programming- advanced 
* yourXYZfloat  1.000 2.000 3.000 Optional user variable for C programming- advanced 
End 
 
Initial chamber alignment: 
 
Make sure there is water or buffer in the chamber.  Apply immersion fluid to both sides of the 
chamber.  Use the new immersion liquid (Cargilie 3421) that does not evaporate.  This should 
last for several days. (Note: Although the refractive index is the same, Cargilie’s surface tension 
is less than water. See the note on chamber construction. Re-apply a little at the beginning of 
each day to avoid any problems later in the day.) 
 
Open the software.  You may need to restart the program several times until the lines on the 
screen are wiggling. If they are straight with no variation, the program is not communicating 
correctly with the instrument. 
 
Find the pipette tip. Reset the motor position by resetting the motorPIC (under Tools ->Reset -> 
motorPIC). This does the same function as the reset button on the control board.  This reset 
should be done when the trap is positioned slightly above the pipette tip.  Set the position by 
pressing alt-1. Find the positions of the dispenser tubes and mark the position with alt-2 and alt-
3. Now, pressing the number 1, 2, or 3 will automatically take you to the memorized position. If 
during the movement, the mouse is moved, it will abort and stop moving.  You can save these 
preferences under File -> Export Preferences. You can import the previous days’ settings under 
File -> Import Preferences. Opening the program automatically uploads the preference file. 
 
Turning on the lasers: 



 
Make sure the six metal Side Panels around the hexagon are in place.  Then make sure the black 
plastic Beam Blocks under the Prism Boxes are also in place.  Note in log book that all Beam 
Blocks are in place.   
 
Turn on the laser power supply with toggle switch on the right of the box.  Rotate both “laser 
current” knobs to reduce the current to zero in both lasers.  Press both red “enable” buttons, 
which should illuminate both green “enabled” lights.  Make sure both range switches select 
“power monitor.”  Then, gradually turn the “laser current” knobs to bring the “power monitor” 
reading up to HALF of the typical running values written on the tape next to the meters.   
 
Pull out the Filter Slider knob to visualize the lasers on the TV monitor. There should be several 
focal spots. The single spot is from the yellow laser and should be moved to the middle of the 
star shaped pattern formed by the green laser. You can rotate the laser spots by turning the Retro 
Prism Holder, underneath the left beam block. Adjust the lasers in the x and y axis using the 
orange and green knobs sticking out of the top of the box. 
 
Troubleshooting alignment:  Verify that the “yellow” laser shows as a focused spot on the TV.  
If you cannot see the yellow laser spot, turn off the LED (Motors -> LED). This will dim the 
background on the screen and allow you to better locate the beam and focus it.  To focus the 
single spot, use an Allen wrench to adjust the screw above the right objective in the z-axis (in 
and out from the chamber). There is a long lag time between movement of the wrench and 
movement of the objective, so go slow.  Clockwise rotation brings the lenses closer together.  
Check that there is no air between the chamber and the lens.  An Airey disk, which is a 
concentric ring pattern around the focus, indicates air somewhere in the optical path, which must 
be remedied by adding immersion fluid between the chamber and the lens.  
 
Bring both lasers up to the full running values written on the tape next to the meters.  These 
values are specific to each laser due to variations in the internal laser detector sensitivities.  
Higher powers allow higher pulling forces but shorten the lifespan of the laser.   
 
In the log book, record the following readings for each laser: Power Monitor, Laser Current, PSD 
sum, and Iris/Sum (empty trap).  Obtain the Laser Current value by turning the range switch on 
the laser power supply.  Please turn the range switch back to Power Monitor when you are done. 
 
Precise alignment of the lasers – X, Y and Iris/Sum value (daily): 
 
This part of the alignment process precisely aligns the foci of each laser beam, first in the x and y 
axis, and then in the z axis. The alignment of the z axis is indicated by the value of the iris/sum 
value. Ideally, if the foci of each laser are coincident, the iris/sum value will be the same without 
and with a bead in the trap. 
 
First, relax the piezos by selecting “Center Trap”. Move the spots into the center of the TV 
screen using the Adjustment Rods on the top of the optical head.  If the PSD X and Y values are 
greater than 10% of the PSD sum, the detectors may be out of alignment, making it necessary to 
adjust the relay lenses within the optical head- call someone who knows how.  Alternately, the 
piezo tension may need to be adjusted inside the fiber wigglers- call someone who really knows 
what they’re doing!  Next, zero the PSDs by selecting “Zero PSDs”. Only zero the PSDs with no 
bead in the trap. This will set the X and Y values to zero in the software. 



 
Grab a bead of the size that will be in the trap during an experiment. With a bead in the trap, the 
trap deflections should become equal and opposite, as seen in the green and yellow spots in the 
PSD windows. Prior to hitting “Autoalign” minimize the X and Y deflections manually using the 
Adjustment Rods on the top of the optical head. 
Select “Autoalign” and the lasers will move to minimize the X and Y values even closer to zero. 
 
With the trap aligned in the X and Y directions, next align the focus in the Z axis. With the bead 
in the trap, note the Iris/Sum values for the green and yellow lasers and average the two values 
together. Lose the bead by knocking it out of the trap with the pipette tip. Note the Iris/Sum 
values and their average. The average values with the trap full and the trap empty should be close 
to each other, no greater than 0.015 apart. Closer is better. Adjust the focus by moving the right 
objective using a 5/64 inch Allen screwdriver placed into the Worm Gear assembly (don’t drop 
the objective mount by turning the wrong screw).  Move this slowly as there is a lag in the 
response of the system. Again try to minimize the difference in the average Iris/Sum values. 
These values should be recorded in the log book as well.   
 
Alternately, it is also effective to focus the lasers in the Z axis by minimizing the size of the 
yellow laser trap displayed on the TV screen.  However, the TV camera must be set to a 
consistent position for this method to work. 
 
Alignment of the Light Levers (daily): 
 
With the trap aligned properly in the X and Y axis, adjust the light levers by inserting a wrench 
through the holes in the beam blocks to adjust the light levers in the X and Y positions. The X 
and Y values should be no greater than 10% of the total strength hitting the detector. Try to get 
them as close to zero (centered on the detector) as possible. 
 
NOTE:  The mini-tweezers instrument only measures force and distance.  Therefore, it is 
important to regularly check the force and distance calibrations.   
 
Stokes Test (weekly): 
 

1. Zero the PSDs (with no bead in the trap- see above) 
2. Trap a bead from a known size distribution 
3. Select “Autoalign” 
4. Select “Autoalign” again (to turn it off) 
5. Select Stokes’ test (Tool->Stokes’ test) 
6. Select “Zero force” 
7. Select “Move motors” 
8. Move the mouse back and forth to move the motors in X and Y.  Move the motor in Z 

with the scroll wheel (or by selecting “Move motor Z”).  Be careful not to hit the pipette 
or chamber walls. 

9. Freeze the Stokes’ Test screen (“F”) 
10. Rotate the X and Y patterns to horizontal with “Q” and “E” 
11. “E” will display the calculated bead diameter in the lower left corner of the screen. 
12. Repeat for several beads (unfreeze the screen- “F”, clear the data- “shift-~”, rezero the 

PSDs, get a new bead) 
 



If the averaged calculated bead size matches the manufacturer’s reported bead size, the 
instrument is properly calibrated.  This test assumes the fluid has the viscosity of pure water.  
Room temperature changes are compensated via the thermometer readings within the optical 
head.  Beware of buffers containing glycerol and PEG and beads that are not round.  For 
more information, see “How to calibrate.”     

 
Checking Distance Calibration (monthly): 
The light levers measure the position of the traps.  They report their positions in the data file in 
nanometers under the columns “Lever Distance X” and “Lever Distance Y.”  These values are 
calculated using the lever sensitivity calibration factors.  These factors should be checked by 
comparing the Lever readings with motor shaft encoder readings for a trapped bead on a pipette 
using the “Motor/Lever” graph.  See the document “How to calibrate the minitweezers.”     

 
 
 

Basic Mini Tweezers User Guide: Part II 
 

Glossary of terms: 
 
Light Levers report the relative positions of the optical traps.  The light lever window reports 
the brightness SUM and X and Y deviations for each laser in ADC (analog digital convertor) 
units.  The red values are associated with the yellow laser trap while the blue values are 
associated with the green laser trap.         
 
Beam blocks prevent laser light from escaping into the room. The most relevant ones are the six 
rectangular Side Panels of the instrument head; these should all be in place when the lasers are 
on.  In addition, there are also Beam Blocks adjacent to each objective, as shown below: 

 
 

The Beam Block is the L-shaped black plastic piece beneath the silver Prism Box 
 

Controller boards are in the stack of green circuit boards attached to the mini tweezers 
Controller Power Supply.  They facilitate rapid feedback monitoring between the host computer 
and the optical head.  They control constant force, constant position, and motor go-to feedback 
functions.  
 



Iris/Sum values report the ratio of Iris detector output to the PSD SUM output.  They are used to 
determine if the two laser beams are focused at the same point along the Z axis by comparing the 
values with the traps centered, and no bead in the trap, and with the traps under auto-align, with a 
bead in the trap.  See “Basic Mini Tweezers User Guide 1.” 
 
The correction collars are adjustments on the objective lenses for specific thickness cover 
glasses.  For example, #1 cover glasses require a correction collar setting of 0.15, while #1.5 = 
0.17 and  #2 = 0.21.  Using the correct settings will give the sharpest image and strongest traps.    
 
The Worm Gear is a screw that you turn to slide one of the objectives relative to the other in the 
Z direction. It is on top of the rightmost objective (not the thing with the lock icon next to it) and 
is controlled with a 5/64” hexagonal wrench. It has significant mechanical lag, so you have to 
make several turns before it starts actually moving the objective. 
 



The layout of the mini-tweezers apparatus: 
- The upper region of the mini-tweezers apparatus should have all six rectangular plates 

affixed to the sides of the instrument; these are the “side panels” and they prevent stray 
light from escaping the tweezers. Only to be removed if the lasers are off. 

- There are two pairs of holes on the side plates of the tweezers; each hole leads to a small 
hexagonal-tip screw. These screws are used to center the light levers. 

- On top of the tweezers are a camera, a hitch for the bungee cord, and two pairs of screws 
(green, orange). Each of these pairs controls the X and Y positions for one of the traps. 

- Attached to the mini-tweezers and the computer is a stack of circuit boards. 
- These control the input of data from the instrument to the computer. If you want to reset 

the hardware, there is a small gray button on top of this stack. The on/off switch is a 
silver toggle. 

- The big gray box labeled Dual Diode-Laser Driver controls the laser diodes 
• The on/off switch for the laser diode controller is a rocker switch on the right side 

of the box. 
• For each laser, there is a selector switch controlling the readout on the LCD 

screen: power, current, etc... Always make sure that you are looking at the right 
information! 

• The lasers are activated by hitting the red “Enable” buttons. 
• The knobs down at the bottom of the gray box control the laser current. 

- There is a large syringe on the desk, which attaches inside the mini-tweezers to the fluid 
reservoir full of buffer. It has a four-way valve that allows you to vent the syringe, vent 
the buffer reservoir, apply pressure to the buffer reservoir, or cut off the buffer reservoir 
completely. 

- There is a plunger on the desk that controls the filters in front of the camera ( the Filter 
Slider); it has three settings: at full depression, the plunger cuts off the laser light almost 
completely; at 50% depression, some but not all of the laser light gets through; and when 
pulled out completely a lot of the laser light gets to the camera. 

 
Inserting the chamber between the objectives: 
-Slide it up, being careful to not scrape either of the objectives. Tighten both screws to hold it in 
place. 
 
Turning on the lasers: 
Turn on the laser power supply with the toggle switch.  Turn the Laser Current knobs down to zero..  
Press the enable buttons.  Select Monitor Power on the range switches. Increase  the Laser Current 
knob until the Monitor Power (the #s under ‘Dual Diode Laser Driver’) come up to 50% of maximum 
for both lasers.  The 100% max powers are usually written on tape next to the meters. 
 
Relax the wiggler piezos with the computer center trap button, then center the traps by looking 
at them on the video screen (the focused dot and the diamond of four points created by the retro 
reflector) and turning the X-Y control rods on top of the instrument head. 
 One of the lasers will have a lower output intensity (Force PSD SUM) than the other; 
select that one and increase its Laser Current knob while watching the Power Monitor up to 
80% of maximum power.  This level is sufficient for most experiments while maintaining good 
laser life. 



Make the other laser’s output intensity (the top numbers on the computer monitor in the PSD 
window) match that of the first laser. The second laser’s internal Monitor Power should then 
end up below 80% of its written maximum. 
In the notebook, write that the beam blocks are still in place.  Record the monitor powers, the 
laser currents (turn the knobs next to the five red LEDs to display currents—make sure to switch 
back to ‘Laser Power’ when you’re done!), and the laser output intensities at the top of the PSD 
window in the logbook 
Do the Stokes’ Law Test (below), recording the iris/sum ratios and the measured and actual 
diameters of the bead in the notebook.  

 

The purpose of the Log Book is to record the instrument user and condition at various times.  
Specifically we want to know if the lasers are failing with time, or if the output polarization is 
changing as indicated by changes in the light-lever to the force-detector sums. Also it is useful to 
remind users to check their safety guards and beam blocks which must be in place to prevent eye 
injuries.  The log book can also be used to record calibration checks such a Stokes’ drag test or a 
Motor/Lever distance calibration.  Finally, the log book is a good place to record bugs and 
complaints and suggested improvements.  It is best to record bugs all together on the back pages 
of the book. 



    Mini-Tweezers Log Page 

Date: 

Name: 

Check here if all beam blocks are in place before turning on lasers □ 
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Iris/Sum (bead in trap)  
 
 

 
 

Light lever sum (blue) 
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Getting ready to record data 

- Hit center trap, and align the lasers manually with the knobs on top of the miniTweezers 
(do this rarely—after manual adjustment, things drift for about 20-30 minutes!).   

• To view the lasers’ positions relative to one another, adjust the plunger controlling the 
light filters to its center position, so some (but not all) of the laser light is sent to the 
camera. 

- Zero the PSDs before trapping the bead (important for measuring force) 
• Trap a bead, hit Autoalign (control-A), then turn off Autoalign 
• If desired, manually adjust light levers (through the holes in the sides of the 

miniTweezers head) Again, do this rarely! The optics take a while to settle after 
adjustment. 

- Zero the light levers (for measuring extension) with the button in the program.  This is 
only really necessary for constant-position protocols (e.g. P2) but it is a good habit 

- Turn on autoalign, then hit the zero force button 
- Record data 
- Publish 

 
The protocol for taking data and catching new beads when everything has been 
adjusted and the lasers are stable is more straightforward: 
 

1) Catch a small bead, and mount it on the pipette tip with suction. 
2) With the trap empty, center the trap. Zero PSDs. 
3) Catch a big bead, bring it close to the pipette. 
4) Make sure that the pipette has zero suction on it (it will mess with the force when 
1. the beads are close together) 
5) Autoalign with the big bead in the trap, hit zero force button 
6) Bring the trapped bead to near the pipette bead, then fish by moving the trap in Y. 
7) When you catch a fiber, make sure that the X and Z forces are zeroed when the Y force is 

about 5-10pN. 
Open a new data file and start collecting data. 

-  
 
Stokes’ Law Test: 

- Zero the PSDs with no bead around (only do it by hitting the button if they’re not too far 
off, i.e. below 1000) 

• If the PSDs are more than 1000 off, hit the main_reset button on the circuit board 
stack to reset the hardware, or adjust the PSDs with the screws on the top of the 
mini-tweezers. 

- Catch a bead 
- Move at least half of a screen away from any glass surfaces or bubbles 
- The PSDs should be deflected in symmetrical and opposite directions 
- Turn on auto-align (control-A) and turn it back off again 
- Go to Tools à Stokes Test 
- Record the iris/sum ratio with the bead in the logbook as ‘full’ 
- Lose the bead, then record the iris/sum ratio again in the logbook as ‘empty’ 



• If the ratio goes up when the bead is trapped, this means that more light is being 
caught by the iris—i.e. that you may need to adjust the objective focus slightly. 
This is probably only necessary once, when installing a new chamber. 

• Adjusting Objective Focus: 
§ #1 cover slips require about a ~0.17 mm setting on the correction collar 
§ Hit center trap on the program before adjusting the objective focus 
§ The Worm Gear is a small horizontal cylinder just above the objective lens on 
the right 
§ The iris/sum ratios should ideally be within ~0.010 of one another; differences 
significantly greater than this would suggest adjusting the objective focus 

- Re-capture the bead, move the bead at least 10 diameters away from the pipette 
- Do the Stokes law test with autoalign off 
- Move trap around; you will see some parallel diagonal lines. Can scroll the system in the 

Z direction to form the third line 
- Hit f to freeze the screen 
- Use Q/E to make the lines horizontal, then hit E to display the corresponding bead 

diameter in the lower left of the screen 
- Record the “diameter” and the actual value given by the company on the diameter of the 

beads in the logbook 
 

Hopping Test (optional: used to detect trap drift or check trap stiffness): 
- Catch a bead in the trap, autoalign, then get rid of the bead 
- Move trap over a bead held on the pipette 

• Move the trap such that the PSDs are centered 
- Hit autoalign 
- Center the PSDs by moving the trap again 
- Turn off autoalign 
- View the window for hopping in the program (Graph à Hopping) 
- Execute the ‘hopping’ procedure (under the “move trap” button) to make the traps wiggle 

back and forth in opposite directions (not required) 
- Non-zero slope indicates that the pipette is drifting with time 
- It’s possible to obtain the trap stiffness by trapping a bead and hitting the ‘stiffness’ 

protocol at several different forces 
 
System Shutdown 

- Dial down the laser diodes to zero power 
- Hit the red “enable” buttons 
- Hit the main rocker switch on the control box to turn off the diodes, and turn off the 

circuit board stack as well. 
 
Troubleshooting: 

- Known software bugs: 
• Sometimes the program crashes in the middle of data collection. It’s not a super-

common event, but it has happened a few times for me in six months. 



• Sometimes the “Tools” menu on top of the screen no longer works, making it 
impossible to change the parameters of a pulling/clamping/etc. protocol without 
actually running it and hoping that the parameters window will pop up for you. 

• Rebooting the program is the only solution I have found to this. 
- The average Iris/sum ratios of the two lasers change by more than 0.010 between 

“auto-aligned with trapped bead” and “no bead with autoalign off” conditions 
• One option is to lose the bead, adjust the Worm Gear slightly with the filter slider 

set at the intermediate position until the center laser looks like it’s in focus, and 
try again; a short cut is also to keep the bead in the trap, with auto-align on, and 
adjust the Worm Gear until the values are close to what they were without the 
bead. 

- One of the lasers isn’t visible on the camera, even at moderate power (50%). 
• Sometimes the Worm Gear on the right objective needs to be adjusted, to bring 

one of the lasers into focus. Removing and replacing the chamber has also been 
known to fix this issue in the past.  Probably there is air between one lens and the 
chamber.  Add immersion fluid and move chamber to get it to flow in. 

- Things in the chamber used to be focused and visible, but now they aren’t 
• There could be a bubble in the chamber, or between the chamber and the two 

objectives. Try to flow some buffer through the chamber, or to put more fluid 
between the chamber and the objectives. 

- When I move the chamber a long distance in the Z direction, suddenly the chamber 
gets super fuzzy 

• This happens when using the Cargille fluid instead of water on the objectives: 
since this fluid creates a more dramatic meniscus than you get with water, so you 
can’t move things in Z as far as you could before. 

- The pipette and trap beads are out of alignment with each other in the Z plane 
• Use pageup/pagedown to step the chamber up or down in the Z plane. Pagedown 

lowers the net Z force, and pageup raises it. 
- A light lever’s deflection (X or Y) value is very high, even after I have centered both 

traps 
• Make sure that you hit “A&B” before hitting “center traps” 
• If this fails, you must adjust the appropriate centering screws on the side of the 

miniTweezers box (the ones recessed in the body of the tweezers and accessible 
with a 5/64” hexagonal wrench). The X coordinate is controlled by the upper of 
the two holes; the Y coordinate is the lower of the two. 

- A light lever’s power is unusually low, or zero 
• Rarely a piece of tubing within the instrument (behind the beam blocking plates 

on the mini-tweezers) has gotten in the way of the light lever beam. This has been 
corrected in Laser Tweezers East with some tape, but it may still slip. 

• Otherwise, manipulate the light lever with the screws in the sides of the mini-
tweezers; the light lever may be totally missing its sensor. You may find that 
scanning in one or both axes will eventually get you into a range where the light 
lever is hitting the sensor again. 

- In force-ramp mode (P1) the trap doesn’t ever get down to the minimum force, so it 
keeps on moving the beads towards each other until they collide. 



• You probably have some issues with the force calibration, due to residual flow in 
the chamber (or suction from the pipette), a mis-alignment of the beads (most 
often in the Z axis!), or the fact that the force on the trapped bead wasn’t zeroed 
properly before catching a fiber. 

- The trapped bead feels an increase in force as it approaches the pipette 
• Carefully focus the pipette bead in and out on the Z axis and look for a decrease 

in the force error.  Always use the big bead in the trap and the small bead on the 
pipette. 

• There may be some residual suction in the pipette that is biasing your force values 
when the bead gets too close. Make sure that the plunger in the syringe connected 
to the pipette has been removed completely. 

- Something very strange is happening with the data readouts (things are frozen, or a 
number suddenly got enormous, or no data are being displayed on the screen at all) 

• Try resetting the hardware, using the button on top of the circuit board stack 
attached to the miniTweezers. 

• There are two reset buttons on the stack of horizontal circuit boards: 
 The usb_reset button resets the USB (not frequently used) 
 The main_reset button resets all the piezos and other tweezers hardware. 

Use this if the numbers go on the fritz. 
- The program starts up but isn’t collecting data from the instrument 

• Try closing and re-starting the program several times, or resetting the tweezers 
hardware with the button on the circuit board stack. 


